
- New in Release 1.91 (December 1997)

New Features...

- Automatically skipping faulty files when copying, deleting or searching... If an error occurs during 
a copy, delete or file find task, subsequent files that cause the same error can be skipped automatically. 
There is a 'Skip All' button in the message dialog box that appears after the first fault. Press this button to 
skip further error messages of the same type. The corresponding files will be omitted automatically. 
Please note: This only applies to the following types of errors. If other errors occur, there will be additional
error messages.

1. When copying files and directories... Error type: the source file couldn't be opened. (Note: To omit files 
that cannot be opened from the beginning, check the 'Omit files that cannot be opened' check box when 
setting up the options for the copy task.)

2. When deleting files and directories... Error type: a file couldn't be deleted. (Note: The 'Skip All' option 
only applies to error messages that are shown by 'The Next Tool'. If the operating system shows 
additional messages (e.g. if the recycle bin is involved), these messages will not be suppressed.)

3. In case of a file find / find in files task... Error type: a file couldn't be opened.

- Printing, editing or copying the representation of a directory hierarchy... The representation of the 
directory hierarchy that is shown in the tree pane of a display window can be printed, edited with a text 
editor or copied to the clipboard. In tree/folder display windows, there is a new 'Tree Pane' submenu in 
the 'Edit' menu that contains 'Copy', 'Edit' and 'Print' options to execute the corresponding commands. In 
tree display windows, you'll find the same options directly in the 'Edit' menu. (Note: Up to now, 'Copy', 
'Edit' and 'Print' commands were only available for the representation of the folder pane of a display 
window. In tree/folder displays these commands are now in the 'Folder Pane' submenu of the 'Edit' 
menu.)
 
- Displaying filenames... In the folder pane of a display window, you can disable that filenames and 
filename extensions are shown in separate columns. To display the complete filename (including the 
filename extension) in the 'Name' column, check the 'No Separated Extension' check box on the 'Display 
Sequence' page of the 'Display' dialog box that you can open via the 'View' menu. Alternatively, check the 
corresponding option in the context menu that you can open by clicking the button bar on the top of the 
folder pane of the display window with the right mouse button.

- The recycle bin is no longer used for moving or renaming... As the Windows® recycle bin only 
allows to undo deletions by selecting the desired filenames, moving and renaming of files is now always 
done without the recycle bin. In the Windows® recycle bin, undoing the movement or the renaming of a 
file is anonymous (i.e. you don't see the filename) and one can take back these actions only in the 
reverse order of the original actions. Therefore we think that mixing actions of the explorer and actions 
that were executed by T.N.T. may lead to confusing situations.
So please note: Only the deletion of files can be taken back via the recycle bin if you check the 
corresponding check box when setting up the options for the delete task and if the Windows® recycle bin 
is activated for the corresponding drive.

- Saving files... When saving a file in the text editor or when saving a selected area in the file viewer, the 
'Save As' dialog box now also contains controls to browse through the directory hierarchy.

- Browsing through the directory hierarchy... Changing the current directoy when browsing through 
the directory hierarchy is much faster now.

- Recently used directories... The list of the recently used directories, which can be accessed by clicking



a drive icon in the taskbar or the drive register of a display window with the right mouse button, is now 
sorted alphabetically. Directories that don't exist any more are removed from the recently used list if they 
are chosen again. Directories that are only visited temporarily while browsing through the directory 
hierarchy are no longer included in the recently used list.

- Comparing files... If a compare command is started, the current directory of the second display window
is automatically proposed as the target directory for the compare task.

- Comparing floppy disks... If only the manufacturer id differs when comparing two floppy disks or a 
floppy disk and a disk image, the compare task continues and the difference is reported at the end. 

- GZIP archives... Files with the filename extension '.Z' are no longer treated as GZIP archives by default.
As most of these files are not compressed with the original GNU-ZIP format, T.N.T. is not able to extract 
their contents. Therefore '.Z' files are no longer shown as directories in the tree pane of a display window 
and the '.Z' file type is no longer registered with T.N.T. during the installation of the program. To check 
whether a file with the extension '.Z' is an original GNU-ZIP archive, double-click the file with the right 
mouse button. If T.N.T. is able to read the contents of the archive, a new display window appears 
otherwise a file viewer opens.

- New Web Site... For latest information and support refer to:

http://www.schliesser.de

or e-mail to

support@schliesser.de

Solved Problems...

- Hard disks with more than 2 GB free space... Displaying more than 2 GB free space didn't work    
under Windows® 95 OSR2.

- [+] symbols... The following errors occurred with the [+] symbols that are used to identify folders that 
contain subfolders:

1. In the 'Menus' dialog box, the [+] symbols were always faulty.

2. When copying from a drive with activated [+] symbols to a drive with disabled [+] symbols, the [+] 
symbols appeared on the target drive.

3. Disabling the [+] symbols for net drives didn't work. If the [+] symbols were disabled, they were shown 
and vice versa.

4. If a folder with a [+] symbol didn't exist any more (i.e. another program had removed the folder) after 
the execution of a file command that worked on the contents of this folder, T.N.T. might have crashed.

- T.N.T. crashed when displaying certain directories... In case a IE4.0 beta, a kernel update or certain 
net drivers were installed, T.N.T. might have crashed when displaying certain directories. (Note: The crash
occurred while the icons for certain '.pif' files were determined.)

- T.N.T. crashed when displaying long tooltips... If there were drive labels longer than 63 characters 
(e.g. drive labels of net drives), T.N.T. crashed when such a drive label appeared in a tooltip.

- Modifying the order of sorting in display windows... If the last criterion of sorting (normally 
'Attributes') became the first one, sorting the entries in the folder pane of the display window might not 



have worked correctly.

- Deleting directories inside disk images... T.N.T. might have crashed after the last directory inside a 
disk image was removed.

- Copying files... If the data carrier was exchanged during a copy task (e.g. in case the files didn't fit in 
one floppy disk), T.N.T. might have crashed at the end of the copy task.

- Copying floppy disks... On certain systems, writing the same contents to several floppy disks didn't 
work. You had to start a complete new diskcopy task for each disk.

- Executing programs in 'The Next Tool's command line under Windows® NT... Executing programs 
in 'The Next Tool's command line didn't work under Windows® NT if the path of the executable contained 
long filenames.

- Editing files in the hex-view of the file viewer...    Searching for certain patterns might not have 
worked any more after a file was modified in the hex-view of the file viewer.

- Registered file types... If file types were registered by means of 'The Next Tool's 'Registered File Types'
dialog box, opening such files (e.g. by double clicking a corresponding file) didn't work in case the path of 
the file contained spaces.

- T.N.T. crashed with VueIcons... If VueIcons, a Windows® add-on that displays images as icons, was 
installed, T.N.T. might have crashed when displaying a directory that contains image files.

See also:

New in Release 1.90 (May 1997)
New in Release V1.81 (January 1997)



- New in Release 1.90 (May 1997)

New Features...

- Better adaptation of the T.N.T. display windows to the Explorer... The representation of tree 
structures corresponds to the Explorer now. If desired, the handling of files and directories, i.e. selecting 
entries as well as drag-and-drop, can be done by means of the left mouse button and according to the 
Windows® standard.

1. Tree Structures with [+] Symbols...

Preliminary remark: In the T.N.T. display windows, the [+] symbols, which serve to identify those folders 
that contain subfolders, are determined in the background. The tree structure itself appears instantly and 
you can operate on it immediately. Therefore (dependent on the speed of the drive) the [+] symbols 
appear with a short delay.

On the 'Directory' page of the 'Settings' property sheet, there are three check boxes by means of which 
you can enable/disable the determination of the [+] symbols for the following groups of drives: 1. floppy 
disks and CD-ROMs, 2. hard disks and RAMDrives, 3. net drives. If you want to avoid the background 
activity that is caused by the determination of the subdirectories, check the respective check box for the 
corresponding drive type.

Note: For archive files (files that have the filename extension '.ZIP', '.RAR', '.LHA', '.LZH', '.LZS', '.ARJ', 
'.TAR', '.GZ', '.Z', '.TGZ', '.TNT' and '.VCP' are automatically treated as archives) it is determined likewise 
whether they contain subdirectories and [+] symbols are displayed if necessary. A [!] symbol in front of an 
archive indicates that the type of the archive could not be determined. (The archive may be in use by 



another program at the moment or the file may indeed have an unknown format.)

2. Drag-and-Drop with the Left Mouse Button...

Preliminary remark: By default, inside 'The Next Tool' only selecting entries is done by means of the left 
mouse button and the selection is persistent. That means that selected entries remain selected if another 
entry is clicked with the left mouse button. By dragging the mouse with the left button pressed, you can 
continuously select entries. Drag-and-drop is done by means of the right mouse button.

To activate selection and drag-and-drop with the left mouse button according to the Explorer, check the 
'Left mouse button Explorer compatible' check box on the 'General' page of the 'Settings' property sheet 
or choose 'Left mouse button Explorer compatible' from the 'Configuration\Mode' submenu of the T.N.T. 
main menu. (Note: To open the main menu, click the button or the icon of 'The Next Tool' in the taskbar 
with the right mouse button.) Activating the 'Left mouse button Explorer compatible' feature has the 
following consequences:

- The selection of entries (files and directories) is no longer persistent. If you click an entry with the left 
mouse button, all entries that were selected previously are deselected. To select a number of entries, 
keep the 'Control' key pressed while clicking on further entries. To select a number of successive entries, 
keep the 'Shift' key pressed.

- Drag-and-drop of entries (files and directories) can also be done by means of the left mouse button. The
continuous selection of entries by dragging the mouse with the left mouse button pressed is no longer 
possible.

- Working on tree structures (i.e. expanding or folding up branches) is done by means of the left mouse 
button according to the Explorer. Completely expanding or folding up a branch by dragging the mouse 
with the left mouse button pressed is no longer possible. (Note: For a detailed description of the T.N.T. like
handling of tree structures refer to the 'Expanding and Folding Up the Branches of Tree Structures' 
section of the online manual.)

- Notification when deleting in archives... When deleting files inside an archive, a warning appears to 
notify that deletions inside archives cannot be undone by means of the Windows® recycle bin. You can 
disable future appearances of this notification by checking the corresponding check box in the notification 
itself. To enable the notification again, uncheck the 'No -Recycle bin does not work in archives- warning' 
check box on the 'Commands' page of the 'Settings' property sheet.

- Notification when copying archives... If you specify a number of archives as source files for a copy 
task, there will be a notification asking whether you want to copy the archives or extract their contents. 
You can disable future appearances of this notification by checking the corresponding check box in the 
notification itself. Archives are then always treated as files. To enable the notification again, uncheck the 
'No -Extracting instead of Copying- Notification' check box on the 'Commands' page of the 'Settings' 
property sheet.

- Early writing of archive headers... The header structures of archive files are written as early as 
possible, before the actual contents of the archive is written, in order to minimize the loss of data in case 
of a system crash.

- ASP membership... We are now a member of the Association of Shareware Professionals <ASP>.

Solved Problems...

- Determining the date format... The date format (MM/DD or DD/MM) is now determined from the 
Windows® settings.



- Displaying directories that have more than 999 subdirectories... Now, there are four digits in the 
status bars of the display windows to display the number of subdirectories.

- Optimizing the width of display windows... Optimizing the size of a display window (by double-
clicking the title bar of the window or by pressing the maximize button) as well as restoring the original 
size did not work properly in case the optimal width of the window was wider than the screen size.

- Deleting or moving files and directories... When deleting or moving files or directories, 'The Next Tool'
might have crashed if several tasks were working on the same data.

- Modified attributes of directories... If the attributes of a directory were modified by another application 
while T.N.T. was executing a file command in a subdirectory of the respective directory, T.N.T. might have 
crashed when the command was finished.
 
- Drag-and-drop of files in the 'Menus' dialog box... 'The Next Tool' crashed if files were dropped on 
the 'Filename Patterns' pane of the 'Menus' dialog box if a pre-defined menu was selected in the 
'Menus/Groups' pane.

- Changing the drive of a display window... When changing the drive of a display window, the window 
was closed if the new drive was not accessible. Now the old drive is displayed again.
 
- Execution of external programs... An external application that was started by T.N.T. might have 
opened outside the visible area of the screen. 

- Replacing strings in the text editor... When replacing strings in the text editor with the 'Confirmation 
before replacing' feature enabled, the string that was found might not have been visible when the request 
for confirmation appeared.

 
See also:

New in Release 1.91 (December 1997)
New in Release V1.81 (January 1997)



- New in Release V1.81 (January 1997)

This is the first English release of the software 'The Next Tool' for Windows® 95. You can obtain new 
releases of the software online at the following locations (information is subject to change):

- WWW...

http://members.aol.com/TNTWin/

- FTP...

members.aol.com
cd /TNTWinENG
binary
get tntwin95.exe

- AOL®...

<will be updated soon>

- CompuServe®...

<will be updated soon>

- NEXUS BBS...

+49 - 511 - 95 088 97 (28800 Baud and ISDN)
Login: tnt95eng Password: guest

- FIDO Request...

2:2437/38 (28800 Baud and ISDN)
Magic: TNT95ENG

In case of further questions or comments, please contact:

Mail:
Joerg Schliesser
Software Development
Rotenwaldstr. 41 A
Stuttgart, 70197 
Germany

Fax:
+49 - 711 - 65 99 556

E-mail:
TNTWin@aol.com
TNTWin@compuserve.com

FIDO:
Christian Hagenah@2:2487/3002.3



See also:

New in Release 1.91 (December 1997)
New in Release 1.90 (May 1997)




